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About MX/QX Dashboard Software

The MX/QX is the non-intrusive intelligent actuator of choice
for users demanding safety, quality, ease of configuration and
technology leadership. Flowserve Limitorque’s commitment to
technology leadership is demonstrated in an available Bluetooth®
option that permits a user to download or upload configuration
routines via a standard low-power wireless communication
path to an actuator. The MX/QX actuator can communicate via
Bluetooth with a Bluetooth-equipped PC, PDA, or cell phone
compatible with the Microsoft Windows® Mobile platform and
the MX/QX Dashboard actuator diagnostics GUI (graphical user
interface) software. This document outlines the flexibility of the
Dashboard software.

The MX/QX Bluetooth option contains a Frequency

Hopping Spread Spectrum (FHSS), which enables a reliable
communication link, even in a “noisy” environment. The
Bluetooth option also contains 128-bit data encryption to protect
the privacy of the link. Bluetooth communication is accessible up
to 10 meters (~30 fi.) from the actuator in all directions, and the
ability to enable the Bluetooth communication link is password
protected. When the Bluetooth link is enabled, a visible blue LED
in the controls LCD window signifies that an active Bluetooth
link to the actuator is established.

The Dashboard actuator software program permits a user to
easily access either the configuration routines or the diagnostics
capability of the MX/QX actuator using a Bluetooth-equipped

PC or PDA with the Windows Mabile 5 platform. Dashboard

is driven by GUI and parallels the menu selections of the MX/
QX (see Installation and Operations manuals LMENIM2306 and
LMENIM3306). It can be used to change or view configurations
up fo 10 meters from the actuator when a Bluetooth link is
established. A secure Bluetooth link must be established before
configurations can be altered, ensuring security and safety.
Once the link is established, Dashboard can be used to change
or view the default configuration in either active online mode or
background mode.

Online mode allows a user to make unit configuration changes
in real time by simply answering “Yes” or “No” to the menu
prompts. Exiting the program saves the changes to the
MX/QX. These changes can be subsequently downloaded
from a Bluetooth-equipped PC or PDA and uploaded to other

FCD LMENIM2338-01

MX/QX actuators that require identical configurations. This
feature speeds the setup of the remaining actuators.

Offline mode allows a user to program a unit configuration, save
the configuration to a PC or PDA, and upload into an

MX/QX once the Bluetooth link is established. This feature
enables the user to assign a unique configuration for any
number of actuators in a non-volatile environment, save it to

the computer device, and schedule the upload to the actuators
when planned maintenance is performed.

Diagnostics can also be downloaded from the actuator into
a PC or PDA via Dashboard and saved for further evaluation.
Dashboard can be used to analyze this data or e-mail it to
Flowserve Limitorque for evaluation.

These features are available up to 10 meters from the

MX/QX actuator equipped with the Bluetooth (BT) option.
Dashboard can also be used with the IrDA port supplied

with each MX/QX unit. IrDA (IR) communication is limited

to < 1m. It also requires a link to be established, but the effective
communication distance is typically less than one meter to avoid
cross-communication with neighboring devices.

When the MX/QX software is revised, Dashboard can be used
to implement newly released software and upload it to the
MX/QX. It is recommended that the IrDA link be used to upload
new software into the MX/QX actuator.

NOTE: This version supports only the ENGLISH language option.
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Installing and Activating Dashboard

Dashboard is supported on the following computer systems:

PDA - Microsoft Mobile 5 or 6 operating system only with
Bluetooth and Infrared capability.

Laptop* - Microsoft XP® operating system with Bluetooth
and Infrared capability. Microsoft Windows VISTA® not
supported.

Desktop* - Microsoft XP® operating system with Bluetooth
and infrared capability. Microsoft Windows VISTA not
supported.

*Internal or external Bluetooth or infrared devices supported
on most PCs. Refer to manufacturer’s instructions for
installation.

Dashboard is available free of charge when the MX/QX with the
Bluetooth option is purchased, and it can be downloaded from
www.limitorque.com or on CD.

NOTE: A nominal fee is charged for Dashboard if used on the
infrared equipped only MX/QX actuators.

PDA Installation

1.

Using Microsoft Active Sync®, copy the dashboard.cab file to
the PDA directory of your choice .

On the PDA, open the folder where the .cab file resides and
select it.

Follow the installation instructions (Windows Mobile
generated).

NOTE: Dashboard .cab files for the PDA are provided as
Widcomm or Wincomm versions. If the program generates an
error after installation, the incorrect version was installed.

PC (non-PDA) Installation
1. Insert the CD in your PC CD drive.

2. Open file explored and select the setup.exe from the CD drive
directory.

-  Typ= the name of & program, foldes, document, o
— L Inkermest resource, and Windows will open & For you,

|| cancel || growse. |

3. Click OK and follow the installation instructions.

Dashboard (PDA or PC) is encrypted and requires a key to
unlock the encryption. When the Dashboard software is first
activated on your device, a keycode will appear. For example:

* Dashboard Keycode = 7790793D6995DD8

This keycode is then used to generate a random key to unlock
the software. For example:

» Dashboard Key = 699907DD893705D

Each key code is unique for every PC and PDA,; therefore, the
end user must obtain a key code for every installed platform.

Once the key is validated, the end user must accept the terms of
the agreement prior to first use.

The key to unlock the code is available from the factory by calling
434-528-4400 and asking to speak with a service representative.

It
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MX/QX Configuration

To configure the MX/QX “port” setting, refer to the
LMEIM2306/3306 for detailed instructions.

To use the MX/QX Downloader option on the dashboard, the
MX/QX must be configured for IRDA in the “port” setup.

The ModSim option on the Dashboard is supported either
via IR or BT.

Setup example for the IR setting in the “port” menu:

ARG ARG (aNG

T e ——[ [
3 IEENE Uy ey (LI F =
| R T e et
""‘“._. ""-__. \""-_ %
lﬁm %.\r. -éw
S o oFi
bord aa

Once the port is configured, Dashboard may be used to
communicate with the MX/QX via the user selected Local port.

Note: When using the IR option, line of sight is required with
the device. For best results hold the IR device approximately
12 cm or less, from the actuator. BT option supports a
maximum distance of 10 meters from the device.

Configuring the MX/QX BT option:
= In the ‘ports’ menu, select the BT port.

= Each BT-equipped MX/QX has a unique identifier. Note for
future reference.

= Configure the BT password, a maximum of 16 alphanumeric
characters.

« NOTE: Limitorque strongly recommends the use of a
non-default password on the MX/QX for security reasons.

e The MX/QX is now ready for use with the Limitorque
Dashboard application.

To obtain the default password or for password recovery, service is

available. Contact Limitorque service coordinator at (434) 528-4400.

FCD LMENIM2338-01
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Creating the Dashboard BT Link

This document is designed to demonstrate the capabilities

of the Bluetooth link for communication with the MX/QX. IR
communication is identical except for the initial selection of the
IR/COM link. From this point forward, the BT link shall be used
as a reference.

The link is established per the following procedure:
* Verify the MX/QX is configured for the BT port option.
* Record the MX/QX password.

* Using the Dashboard application, perform the following:

- Select the “Bluetooth” button.

[ Difffne Mode
e~ ;m;aa - ., s
IR AT Bk 5
Sedet olffne mode ko owerk olfine

FCD LMENIMZ2338-01

The Dashboard application will scan for all BT devices in range.

NOTE: The application will identify all BT devices in range
including and not limited to cell phones and PCs.

:?3: Bluetaoth Scan

Seannmg complete. Select davice from
ke st o it BACE bathan 1o cancal
Biushocth sefechon

DELLTIEWBD 1524001 abb446cab] A
FLSM-L FE052 a0 00k T 4555
FLSNA TIR0B0EY 0040951 SEa04)
FLSM-L PSFI0E0E 00035155035
FLEMNN 23567 (000981 81 0ch) »
L1 ' = *

o

[ Rescan i

Note: The FLXMX/QX refers to the MX/QX actuator.

* |f the desired actuator does not appear in the scan window,
move closer to the actuator and press the “Rescan” button.
If the actuator still does not appear in the scan window,
verify the MX/QX actuator in question.

» Select the desired actuator with the mouse cursor (PC
application) or stylus (PDA application) and wait for
the “ACCEPT” button to activate.

NOTE: If the MX/QX is configured for password protection, enter
the password in the Dashboard input field when prompted.

Proceed to page 9.
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Dashboard Offline Mode

The Dashboard offline mode allows the user to configure the
MX/QX configuration prior to the system upload. The user is
allowed to change parameters associated with a standard
MX/QX configuration such as REMOTE mode, LOCAL mode,
ESD, etc. Factory-set parameters: VOLTAGE, FREQUENCY,
UNIT SIZE, UNIT SPEED, LIMIT SWITCHES are not configurable
using Dashboard, thus allowing the user to upload a desired
configuration to similar installed MX/QX’s without the risk of
altering factory-set “as built” configuration.

To access the offline mode, perform the following as illustrated:

.rﬁ!: daztilboard
| Filo. Target Cptions  Help

i Oiffne Mods

Ueng config fromMA4_Defoud Conhg
Sefescl G Dubloe bo Lse this langes

The “Offline Mode” must be checked.

* Once the “Offline Mode” is selected, the “GO” button will
activate. Select and proceed to page 9.

FCD LMENIM2338-01
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MX/QX Configuration via Dashboard

This section describes the available configuration options
applicable to the MX/QX. The below illustrations are applicable
to the offline and online modes.

Once in the Welcome screen below, proceed with the MX/QX
configuration detailed below:

L :
X, Walcome

Fike  Tarpet Omtlons  Help

Eardigation | Disgnostics |

Corneclion Status. [Giffine mods
Connechion speed it
Portin Use. [MeeA_Disfanh_Cov

BACE

In the OFFLINE mode, the following user access is available:
File > Exit — Exits the offline mode
Target > Compare — Allows for saved file comparison

Options > Download — Opens the MX/QX Downloader
application

Options > Modsim — Opens the Modsim application

NOTE: All other links are not accessible.

.’!3: Welcomma

Filz. Target Cgtions Help

Coréiguration | Cragnostics |

|

I L b pemote LCD mode

Cormection Stalus. [Connected.
Conmestion speed (BT
Pattin s [Winsoch BT &R

In the ACTIVE mode, the following user access is available:
File > Exit — Exit the online mode

Target > Config > Download — Downloads the MX/QX
configuration

Target > Config > Upload — Uploads a configuration to the
MX/QX

Target > Config > Compare — Compares the saved
configuration to the recently downloaded configuration

Target > Reset — Resets the MX/QX resulting in a lost link

Options > Download — Opens the MX/QX Downloader
application — IR OPTION only

Options > Modsim — Opens the Modsim application; can be
used with BT or IR

NOTE: All other links are for factory use only.

o
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MX/QX Configuration Detailed

This section describes the options and data available using

the Dashboard application. Data includes Frequency Domain
Analysis (FDA), diagnostic information including motor
temperature, encoder status and firmware version information.

To access the detailed data, perform the following once a link
is established:

WARNING: For safety reasons, configuration changes require
REMOTE-STOP-LOCAL switch position in the “STOP” mode.

Press VIEW in the WELCOME screen and observe for below
operation.

0 Raad Confie ..

[Target FLENCC01 234567

Coniig szer 365 modbes tegisters. 712
bytes

Daowrioad Progeess

Flead ragrster 180 out of 365

The user has a choice of pressing ABORT; once the read cycle
is completed, the ABORT button changes to OK.

FCD LMENIM2338-01

Once the register data download is completed, the next display
is as follows:

T MXA Chanpe Sallings El
File Target Ootions Helo
Conliguraton Selechion

Yilve Sefun - |

GotoSolection | [ Soit Alpha

Change ge of e vabes canfiguration
| v close deection and type of
walya gealing

Carhg [Dowrioaded Conlig

BACK

CIOmM| T

In the Configuration Selection, the end user has the option to
change the following parameters [COMMIT button saves the
desired changes]:

CONFIGURATION SELECTION OPTIONS: Configuration follows
menus in the MX/QX 10 MS. Consult 10M.

Valve Setup

Allowed changes: CW (Clockwise to Close) or CCW (Counter
Clockwise to Close), Torque or Position seating.

P .
i, Valve Setup

Dinection | Seating |

A

Change Divection j

Cloze [Dipaction

HELP
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Torgue Setup

Allowed changes: Torque % value from 40-100% [contact
Limitorque before increasing torque values as the actuators
are configured for the desired torque output at the factory].

EE:I: Torque Selup

Clese T oogue Vi 3]

T

Opan Toegue Vales [X]

120 =

BALCK HELP

Position Limif Setup

Note: Encoder values are read only. Precision parameter is
the only allowed change.

B Fositwon Limit Setup

Clase Pasibion Ereoder Limt

-Dpen Potition Erceder Limét

[

BACK HELP

FCD LMENIMZ2338-01

Modutronic Setup

Allowed changes: Modutronic Enabled/Disabled, Proportional
Band, Dead Band, Fail Action, Position, Polarity, and Delay After

Stop.

0 Modutronic Sel lp

I~ Moduraric Enabled
Prop.Band % [15
DesdBendx o 5
Faldcion  [POSITION =]
FalPosiorc  [76

¥ Polaiky - 20  Open

[ Aifber S8 =
Ehi's. % i =

[Sec)
I' BACK | MELP ‘ |

Network Setup Option

Allowed changes: Refer to specific protocol documentation

for detailed information. If a network option is installed, the
appropriate network type will be displayed. Protocols supported:
Profibus DP/PA, DeviceNet, Modbus or Not Installed.

:!3: Hetwork Config...
Satect Nabwork Board Type:
{ppC -
Conliguee I
| Aok | HELF l
=iy
— —— 11
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Status and Alarm Configuration (Relay) Option

Allowed changes: S1-S2, R1-R8 — option dependent [allows for
installed relay changes involving Trigger and Action).

(1} Relay Confliguration

5152 | RiR4| RE-RE|

HELP

Two Speed Timer Configurations

Allowed changes: Timer Enabled/Disabled, Start and Stop
positions (in %), Pulse Time On (max 20 sec), Pulse Time Off
(max 200 sec), Open or Close.

W, Two Speed Timers

Open: Timer | Class Time: |

[ Tinet Enabled

i
£ |

Slop Poshion % 100 =

a
-

Szt Posthons 20 [0

o g
Pulss Tine On fsee] (20 =

2 ] =~ ol
Pulss Tine O fs=c) (1.0 =

FCD LMENIM2338-01

Analog Out Configuration Option

Allowed changes: Function (APT, ATT, Restricted), Output
(Current, Voltage), Offset (4-20ma, 0-20ma), Polarity (20ma-
OPEN, 20ma_CLOSE), Enable/Disable.

B Analog Out

Andiog 0l 1 | Ansleg Dut 2 |

[ Ensble Function [8FT =
Dusput | Cuarent =
Offset | 4-20ma -
Polarty: | 204 = Dpan -

HELP

Remaote Control Configuration

Allowed changes: Modes; 2-wire OPEN, 2-wire CLOSE, 3-wire
INCHING, 3-wire MAINTAINED, 4-wire, Remote User Input,
type; Multi-Control Mode; Digital or Network or Analog control
[refer to the MX/QX LMENTB2300 documentation for detailed
information].

:’!‘E Remole Conlrol Setup E
Fiemrote Controd oda
| 3 We - Mantaned -]
Hemots Coritcd Typa
§ MubrConiiol Mode -]
l BACK. | HELP |
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Local Control Configuration

Allowed changes: Local Control Enable, LED color reversal.

1, Local Control Satip

FCD LMENIMZ2338-01

Inputs Configuration

Allowed changes: Input 0, 1, 2 (ESD, OPEN/CLOSE Inhibit, BOTH
Inhibits, User Input), Input enable/disable, ESD action, ESD set
(Ignore, Open, Close), Inputs 3-5 are for future implementation.

W Local Conbiol Enatile

Lol Centrol Mode
|M&INTAINED -]

I Réverza Red & Green LED

. | BACK | MELP ‘

ESD (Emergency Shutdown) Overrides Configuration

Allowed changes: User selectable defining the degree

of protection required when using the ESD function.
10, £SD Overrides

ESD can overmide the follovwang:
[ ESD Ovemdes inhis
[ ESD Ovwenidas Local Cmd
¥ ESD Dhatiides Shop
I ESD Dvisndas Vabe Sam
™ ESD Dyeinder Lot Phate
[~ ESD Oveniges Dvedoiue
[ ESD Dveinides Dvileng
¥ [ESD Dvemce: Two Speed

™ Local ESD Dvernides KW ESDr

BACK I HELP ‘

1, Can figura Inpuls

oot © | (nput 1| trpue 2] npit 3 <1 ] |

[~ Enable Input
| EsDSs
Statii Fusction

[ESD =

¥ Bpthee vwhin Sxnel Preant
£SO Action _
| =]

‘ BACK I MELP

Monitor Relay Configuration

Allowed changes: Local switch position (Local, Stop),
Overtorque, Inhibit, ESD, non-configurable features are
THOL (over temperature), Jammed and Overtorque.

&, Monitor Re bay...

Sedsct Morsborn Fletay Toggens:
¥ Local Selecked

W Locsl Stop Sefacted

I Dvesioeoue dctive

I ikt Active

I ESD Active

I

-

|" BACE | HELP ‘
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Reset Diagnostics Option Password Configuration

Allows for establishing a new baseline for the OPEN and Allowable settings: 000-999.

CLOSE cycles.

1*3: Password

:@: Rasel Diagnostics

Flassl Diagnastics Checes;
Seb a3 gt MM pastwond
Cancel i qul.
Fasswond

[ el N o
[ Save bazeline nesd open cypols

[™ Sawe baselne nest close cpele

CANCEL o

BALCE, HELP:

Torque Boost Configuration

Allowable settings: AUTO, ON or OFF. Recommended
setting is AUTO.

Unit Tag Configuration

Allowed changes: Maximum of 8 alphanumeric characters
recommended.

0} Torque Boost...

3. Unit Tag

Ut T s Toeque Boost

4T =

[ MOV_2274

14 BATE l MELP ‘ I BATK | HELP |
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Motor Thermostat Configuration

Allows for enabling or disabling motor over temperature
protection [recommended setting is Enable Motor Thermostat].

L ] -
M, Motor ThermosLal

Molor Themrmastet

¥ Enabia Motor Themostat

I5 BACK | HELP ‘

Valve Data Configuration

Allowed settings: Valve Serial Number, Valve Model Number and

Valve Type (linear, rotary, other, undefined). [Valve data should
be obtained from the valve manufacturer.]

1, Valve Dita El
Mahve Dt

|~,«*su 123455758

Vabve Mode! Numbor
[V MODEL 12345678

Valve Tope:
JUNDEFINED -

i BACK HELP

FCD LMENIMZ2338-01

Port Configuration

Allowed settings: IR (infrared - required for firmware download,
BT-optional (Bluetooth), Disabled.

The Bluetooth option settings include BT name, password,
discoverable and security option.

i, Part Config...

Frost Conlig
¥ Ensbls Local Pal

Diagnaatics Pt
| Biuetoc Part -

Corfiguee Bluetooth | |

Blustocth Add: (00 a5 1l ach

Bl oty Fiame .
 ze Unk Sensl Mumber

™ LiseUnit Tag

Ehseboith Paﬁmﬂ.
gder.mmmssm

M Unt i Discovesable
W Enable Secuiiy

HATE HELF
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Backup Power Configuration

If equipped with this option, the recommended setting is to
enable backup, power which allows for viewing unit position
information when the main power is removed.

.'!'3: Backup Power

Backup Pose:

[~ Ensbie Backup Poser Moda

'_:ELM',‘KlHELP

-

Language Selection

Allows for language selection [supported languages listed in the
picture below].

wx | e |

NOTE: To save the configuration in the Change Settings, select
COMMIT.

FCD LMENIM2338-01
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MX/QX Diagnostics

This section describes the diagnostics available via Dashboard.

To access the diagnostics, a BT or IR Link must be established.
This function is not available in the offline mode unless viewing
a saved file. The “Diagnostics” page displays a drop-down menu
of available data as displayed below.

1, View Diagrosiics...
File. Target Options  Help

View Selection.
| &uctuahor Diagrestic State k.

Wiews Hie g stalus of vasious
acluahol tubsyshams.

Diag: [Dowrlosded Diag

FCD LMENIMZ2338-01

Example diagnostic selections are provided as a reference

below:

33, Diagnostic Summary

[Eeviice Faaks:

LOST_PHASE
COMEBINED _FAULT
SYSTEM_FAULT

10 e ot Pl

ARALOG_0 LOST
WOLTS_TO0_Lome

HELF
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FDA is available on all MX/QX actuators supporting the BT
option. The BT option is not necessary to obtain the FDA data.
The data collection function is available via IR. Refer to the
MX/QX documentation for detailed specifications.

To proceed to the FDA Manager, select VIEW from the
DIAGNOSTIC Tab in the WELCOME screen. Follow the prompts.
Once the file is downloaded, the FDA Manager is visible and
available for data collection. To initiate the initial read, proceed
to the FDA tab in the FDA Manager. NOTE: In the display
window, “Run unit to collect needed data” operated the actuator
in LOCAL or REMOTE mode in between the limits. In order to
collect the valid data, the MX/QX actuator must be stroked from
the OPEN to CLOSE when prompted. [Limitorque recommends
obtaining the initial, first installed signature of the actuator.]

i FDA Ma rager

FOA | Spesd |
Fiu urel b cofisct
rieded data
GET FDA "'”TE"""'HQ.:EFD“
\ Tiace Blame
IREEMT= H‘le#
B SAVE

FCD LMENIM2338-01

Once the FDA data capture is complete, the display will
be as follows:

B FDA Manage rb_cl
FOA | Speed|
UNIT RUN | - Ureeadito un FOA
Flaa
VIEN Fligy
TRACE
' Timoe Blame
\ Blo Temee

At this point, the FDA data is available for viewing. Limitorque
recommends the captured data be saved for future reference for
comparison analysis.

NOTE: SPEED DATA in the Speed tab is available by performing
the same procedure as the FDA.
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Proceed to selecting “GET FDA” and the following screen
should appear:

ficcess Dhewice.

Downisading FOA Data..

FCD LMENIMZ2338-01

Once the read completes, proceed with viewing the trace
data. NOTE: The file is saved in a Limitorque proprietary
format. Dashboard is the only utility available to view the
data at this time. The FDA and SPEED analysis is available
for data recording.

i oA Marnagsr E|
FOA | Speed |
FDa

FDA  Speed |

GET SPEED G pmed Trace Poinls
VIEW SPEED CLR DEWICE TRACE
THACE BUFFER

Tazca Mame
Mo Trace
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Viewing Trace Data

Selecting View Trace Data will result in the following display
presuming valid collection of data. The FDA Trace supports
data comparison to an existing saved file.

FDA Trace

:!‘..7!: FIOA Trace Viewer

= X!

0 500 1000 1500 2000 2500

Expott | Compane FDA
I__ BACK, || Heip
Speed Trace
1D, Specd Trace Yiewer |=|I'I_:|E
]‘m] ......':........,.._..E......_g
T R
100004 - | E I
BOO0 1 1
6000 f-----; oot
211 | B e e SR IESERn
0 -
L] 1000 2000 ¢ 300 4000
Expoit
BALCE, Help

FCD LMENIM2338-01

FDA and SPEED Analysis Explanation

The values for the X-axis are in RPM. The values for the Y-axis
are the relative magnitude of the power that the various rotating
components of the actuator are developing mechanically over
the speed ranges. If the magnitude at any given RPM changes
from the stored baseline FDA, then compare the x-axis RPM
for the suspect power magnitude against the expected working
RPM for the components in the actuator. Any component that
is expected to operate at the suspect RPM could be at risk

of excessive wear, and the actuator should be included in a
targeted preventive maintenance program. The suspect parts
could be ordered in advance of the preventive maintenance to
ensure that the downtime will be minimized.

Note: At the current time, the power magnitudes are relative
values.

Operation Log lists parameters associated with the MX/QX
operation since the last reset. This function is a real-time log.

(D} OperationLog...

Log1 |Log2 |
Uit On Tme secs) 754 @
Eivoke Tare [sect) ]hi
Tolad Drive Skesve Tums:  [11.

Fecent Drve Shemvs Tums |11 A

| Totat Cortacion Dpe: |',3
| Recent Contactar Ops: Ea
| Bam | HELP
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Analog Board Summary Status (MX/QX Option)

If optional analog boards are installed, the operational
status of the boards is displayed in real time.

B Analog Board Sumimany

Analog Board Faults ot
SBRDY_NOT_PRESENT
{GBRD2 NOT_PRESEMT

HELP

Mainboard Version Display

The data display pertains to the MX/QX Main Processor
Board indicating the boot, software and CPDL versions.

Vessian Irfcimsior -
Main 5w Version.  08/10.00
Mairi Bool Version B9
Main CPLD Versionr 0

FCD LMENIMZ2338-01

DDC Board Summary Siatus

If equipped with this option, the status of the Modbus
board is provided.

A3, DDC Board Summary
DOC Board Faults: @

NO_FAULTS

BALCK HELP




ﬂ
FLOWSERVE
S

Position Encoder

The MX/QX actuator utilizes a unique encoder design consisting
of absolute and incremental encoders. The

diagnostic data provides the real-time status of the encoder

at the time of evaluation.

1 Ecoder
Encl |Enc2 | Enc 3| Encd | Enes |
Auchustor Posilion
Postion Encoder Status;

[ mann
[ e |

RELP

Relay Summary Status

If optional relay board is installed in the actuator, the
operational state of the board is provided. The standard
relays consist of S1 and S2 relays. R1-R8 are optional.

10 Relay Diagnostic Summany E!
 elayFauts b
NO_FALLTS

Boaid Fauliz
| | R5RE BOARD HOT_PRESEMT
F1FEAFM BOAHD_MOT_PRESENT

HELP

FCD LMENIM2338-01

Motor Thermistor

This table provides real-time information since the last reset.
The temperature in Therm 1 represents the present motor
temperature; Therm 2 displays the highest temperature
recorded during any operation.

L | . £
£ Motor Thermistor

Thenn 1 | Theem 2|

Overtemg Fauk &
Moater Temg [Celcna) |
[ & Thesmisten Faul

Ovestecrg Flecovey Count | i

HELP
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Additional Utilities

The Dashboard is provided with two ufilities that allow for the MX/QX firmware update
and detailed troubleshooting. The utilities consist of the MX/QX Downloader and the
Modsim (Modbus Simulator) software for easy troubleshooting.

An additional mode (Engineering) is provided for Limitorque personnel only.

MX/aX Downloader

The MX/QX Downloader is available only when using the IR option. The downloader
can be used for the SMT (non-BT-compatible MX/QX) and the BT-compatible MX/
QX’s. For use with the BT-compatible MX/QX, the “Default bps” must be checked; for
SMT, do not check the “Default bps.”
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Please change this view to display the latest version of the MXa.
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The Modsim utility allows for internal diagnostics of the MX/QX actuator. This option can be used with BT
(if equipped) or the standard IR port. The Modsim utility is compatible with the SMT (non-BT-compatible
MX/QX) or the BT-compatible MX/QX.
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For detailed register information, refer to the MX/QX Modbus Manual LMENIM2329-00. If additional support
is required, please contact Limitorque service at 434-528-4400.
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Troubleshooting

This section details troubleshooting information associated
with Dashboard to the MX/QX communication.

Link Lost Error

This message is displayed if the MX/QX is reset, IR is out
of range for more than five seconds, or the BT is out of range.

NOTE: Variable Frequency Drives interfere with the IR
connection, resulting in a “Link Lost” message if already
connected.

dashbosrd_pc ﬁi

Request Denied

This error is observed when the connection is terminated
by the user clicking the RESET function. The link must be
established for additional MX/QX diagnostics to continue.

dashboard _pe ﬁ_‘:l
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Supporting Documentation

LMENIM2306 — MX Installation and Operation Manual
LMENIM4019 — Direct to Host Manual

LMENBR2300-00 — Technical Bulletin, Protection/Control/
Monitoring Features

LMENIM2329-00 — MX DDC Manual (register detailed
description)

LMENIM3306-00 — QX Instruction and Operation Manual

For additional documentation, go to www.limitorque.com
and type “MX” and or “QX” in the Search window.

FCD LMENIM2338-01
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To find your local Flowserve representative,
visit www.flowserve.com or call USA 1 800 225 6989

To find your local Flowserve Limitorque representative,
visif www.limitorque.com.
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Howserve Corporation has industry ip in the design and manufacture of its pmduﬂs When properly selected, this Flowserve product is designed to perform
its intended function safely during its useful life. However, the or user of Flowserve products should be aware that Flowserve products might be used in numerous
applications under a wide variety of industrial service conditions. Although Flowserve can (and often does) provide general gundelmes |1 caﬂnoi provide spwln: :Iata and warnings
fol all pussrhle icati The pi must assume the umma.te !ﬁpnmuiulny for the proper sizing and and of

ts_ The p should read and the {IOM) instructions included with the product, and train its employees
and wntraclnrs in the safeuse of Howserve products in connection with the specific auplu:ah(m

Printed in USA.

While the information and speci ined in this li are believed to be accurate, they are supplied for informative purposes only and shouold not be considered
certified or as a guarantee of satisfactory results by refiance thereon. Nnthmg contained herein is to be construed as a warranty or gualamee EXPIESS O mmhed reg.arding any
matter with respect to this product. Because Fowserve is i ing and its product design, the specifications, di and i herein
are subject to change without notice. Should any question arise ing these provisions, the should contact Flowserve Corporafion at any one of its worldwide
operations or offices.
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